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| 3. PRODUCT INTRODUCTION I

Digital panel meters by Load Cell Central are versatile, cost effective solutions to a wide
variety of monitoring and control applications. Depending on the choice of signal conditioner,
they are easily set up for an accurate display of temperature, pressure, flow, weight, voltage or
current, all in appropriate engineering units and with zero and span adjustment when needed.
Setup can be via front panel pushbuttons or the meter’s serial interface. Selective security
lockout of the front panel keys protects against accidental changes to meter setup.

High read rates up to 60 per second (50 for 50 Hz operation) are made possible by
Concurrent Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power
line cycle for maximum noise rejection. High read rates provide accurate peak and valley
capture, and quick response for control applications. An adaptive digital filter supplies a time
constant for the encountered signal noise level, yet responds rapidly to changes that exceed a
selected threshold. Self-calibration occurs automatically after every 17th reading.

The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or from 12-30 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output.

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is
via removable plugs conforming to UL61010C safety standards. All output options are isolated
from meter and power ground to 250 Vac.

Extended meter versions can linearize nonlinear inputs. Up to 180 data points may be
linearized by a computer program that stores setup parameters in nonvolatile memory.
Extended meters can also display rate of change, for example to display flow rate based on
changing tank level.

Alarm or setpoint control is provided by an optional relay board with two or four Form C 8A
mechanical relays or two or four Form A 130 mA solid state relays. The setpoints may be
latching or non-latching, be energized above or below the setpoint, or operate in a fail-safe
mode. The relays can operate from the filtered signal to reduce relay chatter or from the
unfiltered signal for fastest response. Snubber circuits and a programmable relay switching
time delay extend relay contact life.

An isolated analog output of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an
optional analog output board. The output is linearized to the display and can operate from the
filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the meter’s
serial interface.

Ethernet USB, RS232, or RS485 (2-wire half-duplex or 4-wire full-duplex) serial communi-
cations options are available with the Modbus protocol or a simpler custom ASCII protocol.
Modbus operation includes RTU or ASCIlI modes, up to 247 digital addresses, and up to 32
devices per RS485 line without a repeater. Ethernet-to-RS485 and USB-t0-RS485 converter
boards allow a meter to be interfaced to a PC and to multiple meters on an RS485 network.

Meter programming can be via the meter's front panel or a PC running Windows based
Instrument Setup Software (serial interface option required).
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| 4. RECEIVING & UNPACKING I

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

A Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

e This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify
that the proper power option is installed for the power to be used. This meter has no AC
(mains) switch. It will be in operation as soon as power is connected.

e The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored
Black.

e Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

e To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

e Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.

e Verify the panel cutout dimensions, and mount according to instructions.

Symbols used

& Caution (refer to accompanying documents) J_— Earth (ground) terminal.

A Caution, risk of electric shock. /" Both direct and alternating current.

O] Equipment protected throughout by double
insulation or reinforced insulation.

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



6. CONNECTOR WIRING INFORMATION

CONNECTORS

Connectors for signal and power are UL-rated
screw-clamp terminal blocks that plug into
mating jacks on the printed circuit board.
Communication connectors are a single RJ11
plug for RS232, dual RJ11 plugs for RS485,
dual RJ45 plugs for RS485 Modbus, or USB.

P1 - POWER AND DIGITAL CONTROLS

ACHI (+DC HI)
AC NEUTRAL (DC RET)
EARTH GROUND

CONTROL INPUT 2 (+5V OUT)*

ﬁ CONTROL INPUT 1*

DIGITALGROUND
Warning: Hazardous voltages may be present
on pins 4, 5 & 6 of P1 since digital ground is tied
to pin 3 of P5 (-Signal Input). Keep pin 3 close to
earth ground to minimize common mode voltage

[==1=|§=]=l=

DA WK =

+SIGNAL

Note: Control inputs 1 & 2 of P1 are menu

selectable.
LOAD CELLMETER
J5
-10V EXCITATION
-SENSE
-SIGNAL

or shock hazard at pins 4, 5 & 6 of P1.

PS5 - SIGNAL INPUT
DC & PROCESS

Signal Source

EXCITATION [ m@ o — T — n
+EXCITATION 2l D= — — —+

- SIGNAL INPUT 3[EX |7 "t

+SIGNAL INPUT 4| [I1] ¥

2WIREPROCESS TRANSMITTER
-24V EXCITATION

Signal Source

+24V EXCITATION

-+

1T

L
i
i

1
2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

STRAINGAUGE
-10VEXCITATION

+10 V EXCITATION
+SENSE

ST

RTD & OHMS (2-WIRE)
- EXCITATION 1 —|

+ EXCITATION 2

- SIGNAL INPUT 3

+SIGNAL INPUT 4
RTD & OHMS (3-WIRE)

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

[BH||2E

RTD & OHMS (4-WIRE)

1 @@ - EXCITATION 1] mm
+10V EXCITATION 21 I + EXCITATION 2[ A1)
-SIGNAL 3 mm - SIGNAL INPUT 31 I
+SIGNAL 4| LD} +SIGNAL INPUT 4| LI
AC (TRUE RMS) THERMOCOQUPLE
SIGNAL HIGH 1 mm—2,20,200, 600V INPUTS 1[ @
NC 2L ] 2l X1
SIGNALLOW 3] o~ AC NEUTRAL - SIGNAL INPUT 3[ Im —
SIGNAL HIGH 4L M= 0.2V, CURRENT INPUTS +SIGNAL INPUT 4L XD




P2 - SETPOINT CONTROLLER
DUAL MECHANICAL RELAY OUTPUTS

ALARM 1 N/OCONTACT
ALARM 1 COMMON

ALARM 1 N/CCONTACT

ALARM 2 N/OCONTACT
ALARM 2 COMMON
ALARM 2 N/CCONTACT

EEE|[EEE]

QUAD MECHANICAL RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARMZ2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON

DUAL SOLID STATE RELAY OUTPUTS

ALARM1 1| mm— DCORAC
ALARM1 2| [ |— NOTUSED
ALARM1 3L HEHI— DCORAC
ALARM2 4 mmf— DCORAC
ALARM?2 5| mI— NOTUSED
ALARM?2 6| [MI}— DCORAC

QUAD SOLID STATE RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARM2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON

EEE|EEE

EEE| EEE

ALARM4 N/OCONTACT ALARM4 N/OCONTACT

P3 - SERIAL COMMUNICATIONS P4 - ANALOG OUTPUT

UNIPOLAR CONNECTIONS

RS232 INTERFACE Computer 4-20 mA or 0-20 mMAOUTPUT  1[ frm
0-10V QUTPUT 2| X
N/C 6 mmm |—| ISOLATED GROUND 3K
ISOGND |5 mmm GND
RX 4 TX BIPOLAR CONNECTIONS
Q;S g: §>T<S REFERENCE or RETURN 1] [rm
-10V to +10V OUTPUT 2| @I
N/C
- NC 5|
RS485 INTERFACE - FULL DUPLEX RS485 INTERFACE - HALF DUPLEX
ISOGND |6 umm | GND ISO GND 6 = | GND
BRX 5 mm | BTX 5 mmm L
ARX 4 wmm ATX 4 wmm
ATX e ARX ATX/ARX |3 mmm ATX | ARX
R e Y A
1 - GND 1 - GND

RS485-MODBUS - FULL DUPLEX RS485-MODBUS - HALF DUPLEX

(A) RXDO - TXDO 1
3 .
(B) TXD1 * RXD1 (B) TX / RXD1 4 = (B) TX/IRXD1
(A) TXDO - RXDO (A) TX / RXDO 5 = (A) TXIRXDO
6
ra |
ISO GND GND ISO GND g mmm GND
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| 7. MECHANICAL ASSEMBLY I

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

Retaining tab —

with tab release

Retaining tab \ l l \ |

Rear Panel

— Retaining tab

with tab release

Retaining tab
«— g

REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-
tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may be installed in the field. They will be recognized by the software, which will
provide access to the menu items associated with that board. If necessary, remove rear
panel knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Plug Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5




Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, and then carefully
align the board connectors with the openings in the rear panel. If necessary, remove any
rear panel knockouts for new option boards that may have been installed. Ensure that all
option boards are properly aligned with the molded board retaining pins on the inside of the
rear panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal

plugs.
PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

FRONTVIEW REAR VIEW

<4 MM p

(3.78in)
Smm
(0.197in)£ TOPVIEW SIDEVIEW
‘_ l
R I
“-Mounting Paw
102mm
{4.02in) PANELCUTOUT
45 +0.6/-0.0mm
(1.772 +.024/-0.0in)
10mm
v v (039%n) &

92 +0.8/-0.0mm
(3.622 +.032/-0.0in)

Dimensioned case drawings



| 8. FRONT PANEL SETUP KEYS I

Alarm status
indicator —
1 through 4

Menu key ! ' Alarms key
(Reverse menu)

Peak display key L Resetkey
(Digit select) (Value select)

Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols ( > right arrow, A up arrow,
< left arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters shipped from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. This jumper needs
to be removed for the Menu Mode to work, and values under need to
be set to "0" via the front panel for these menu items to be available. The paragraphs
below assume that all menu items have been unlocked.

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

=
m
=
c

PEAK Key. Pressing PEAK causes the peak value of the input signal to be displayed.
The peak display blinks to differentiate it from the normal present value display.
Pressing PEAK again will return the display to the present value.

£V

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter (same as power on). Pressing and releasing RESET without pressing another
key, changes the displayed item if the mode has multiple items. For Item 1, the V LED is
out. For Item 2, the V LED is on. For Item 3, the V LED is flashing.

10
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MENU

ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
LIS again displays the setpoint for Alarm 2. Pressing it again returns to the present value.
KEYS IN MENU MODE

Right Arrow Key (MENU). Pressing > steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the DC signal conditioner
board and no option boards, available menu items are [JIIE, S30lx O3z, HEEG.

Ea, SONNE, ey, . WY, K. If a change has been made to a menu

item, that change is saved to non-volatile memory when the > key is pressed next, and
is displayed briefly.

> Right Arrow Key (Digit Select).
PEAK

e Pressing > from the InPut menu brings up all meter functions available with the
meter's signal conditioner. For the DC signal conditioner, these are [JEIel],
2] rAtiol

e Pressing > from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:

e Pressing > from the dEC.Pt menu item sequentially selects decimal point positions,
which will flash: sKe[slsle| s[sKefele| (s[es[eMels| 'e[ele[e]s| (e[e[sleloc Kele[e[sls!.

Up Arrow Key (Value Select). Pressing A for a flashing item (digit position or decimal
=3l point position) will increment that item. Pressing MENU will save any changes.

S Left Arrow Key (Reverse Menu). Pressing < has the same effect as the MENU key,
R except that menu items are brought up in reverse order.

11



| 9. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of meter operation, any and all
menu items may be disabled or "locked out” so that they are no
longer directly accessible from the front panel. Each function to
be disabled is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and
each function to be enabled is set to "0." The top menu items
Loc 1, Loc 2 and Loc 3 can in turn be locked out by installing an
internal hardware jumper. With the jumper installed, the operator
only has access only to enabled menu items. With the jumper
removed, the operator also has access to menu items Loc 1, Loc
2 and Loc 3.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section
9 and locate jumper “a” in the lower portion of the power supply
board next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS .
Enabled or Disabled

When setting up the meter, it may be necessary to [ Menu Items
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout | [Keegl

digit to "1" if you do not want the menu item to be 1 - Input type selection.

changed by an operator. 2 - Meter setup, configuration
& decimal pt.
Loc 1 3 - Filter selection.

Press the > MENU key until Loc 1, Loc 2 or Loc 3is | 4 - Scale or Lo, Hiinput.
displayed, as desired. Note: the hardware lockout | 5 - Offset or Lo, Hi reading
jumper must be removed (see above). Loc 2

2 - Alarm setup.

3 - Alarm setpoint value
programming.

4 - Analog output scaling.

5 - Serial interface setup.

00000 Loc 3

12345 2 - View peak value

Press > to set the flashing digit to "0" to enable the | 3 - View alarm setpoints

menu item or to "1" to disable. Press MENU to enter. | 4 - Reset (peak & latched alarms)
See the table to the right for list of menu items that | 5 - Reset (meter reset)

can be enabled or disabled.

11111

Press > to display the lockout status, consisting of
1's and 0’s. The left digit will flash. Press > again to
step to the next digit, which will flash.

12



| 10. READING COORDINATES OF 2 POINTS SCALING METHOD I

When the reading coordinates of 2 points scaling method has been selected under Sl
the four menu items below will appear ahead of all other menu items when the MENU or
> key is first pressed from the run mode.

This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a load cell at zero load, and high signal, such as the output of the
same load cell at a known load, are applied to the meter. The desired corresponding low
and high readings are then entered from the front panel. The meter then applies straight line
fit between the high and low calibration points. This scaling method has the advantage of
calibrating the transducer and meter as a system. The actual voltage or current at either
point does not need to be known. This method is ideal for process and load cell meters,
which require zero and span adjustment. It is also available for DC or AC meters. It is not
available with thermocouple or RTD meters.

The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.

Mg

Press Value Select

hal Key

Press Menu Select
Key

Press Digit Select

Apply low signal input
(e.g., transducer output for 0

psi).

LIopHl Press > to display
reading at low signal input
(e.g., 4.021 mA).

oAl Press A to store low
reading.

Apply high signal input
(e.g., transducer output for
known 100.00 psi source).

PSR! Press > to display
reading at high signal input
(e.g., 20.094 mA).

PA[0Re% Press A to store high
reading.

Lord
Mode to enter desired low
reading (e.g., 0.00).

Select digit

to flash.

BN select B thru § for

flashing first digit, [§ thru g for
other flashing digits.

Hi rd
Mode to enter desired high
reading (e.g., 100.00).

Select digit

to flash.

Select K¢ thru g for

flashing first digit, [§ thru g for
other flashing digits.

13




11. DC VOLTS, AMPS, PROCESS, STRAIN INPUT - MODEL: VPI-SC

The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (16), analog output (17), communications (18), and transducer excitation output
(19).

Voltage Ranges Jumpers
FS Input El E2 E3
+200.00 mV A f b
+2.0000 V A f a
+20.000 V B h b
+200.00 V B h a
+300V (UL) B g a
+600V (not UL) B g a
Current Ranges Jumpers
FS Input El E2 E3
+2.0000 mA A e, g b
+20.000 mA A d, g b
+200.00 mA A c, g b
+5.000 A A a,b,g b
1. Letters indicate jumper position. Jumpers are installed on pins adjacent to letters.
2. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
3. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
4. Store spare jumpers on an unused jumper post not associated a capital letter.

SCALE & OFFSET SETUP

For DC voltmeters & ammeters, a scale factor of 1 and an offset of O are used for direct
readings in (milli)volts or (milli)amperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 pA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.

For process & strain meters, scaling is normally set up from the front panel using the > and
A keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Only menu items
applicable to the selected method will be presented.

14



KEYSTROKES FOR VPI-SC SETUP

If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
> Select Key

Press Digit
Select Key

Press Value Select
naal Key

Selection of signal
input type & range

Q
@]
C

600.0U

0.2, 2, 20, 200, 660V FS

O
Ho
<
> o)
@

DC Amps 0.2, 20, 200 mA, 5A FS
Strain gauge & ratio 0.2, 2, 20V FS.
SEtuP 00 00 @ 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (+99,999)
scale factor of 1. ¥ 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 @ 1=Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground € 1=Hold, 2 =Tare
False = I?Jgic% (5V o)r 1 = Peak or Valley Display, 2 = Tare
open) 1 = Tare, 2 = Reset
B 1=1,2=1, decimal point = XXXXX
1=0, 2 =1, decimal point = XXXX.X
1=1, 2 =0, decimal point = XXX.XX
1=0, 2 =0, decimal point = XX.XXX
Bl 1=1,2=1, decimal point = XXXX.X
"~ 1=0,2=1, decimal point = XXX.XX
1=1, 2 =0, decimal point = XX. XXX
1=0, 2 =0, decimal point = X.XXX.X
B 1 = Function Reset, 2 = Display Blank
B 1 =Hold, 2 = Display Blank
I\ 1 = Peak or Valley, 2 = Display Blank
[ 1 = Tare, 2 = Display Blank

1 = Valley Display, 2 = Peak Display
D 1 =Tare, 2 = Reset Tare to Zero

Both inputs 1 and 2 set to logic 1 for selec-
tions @, B, B}, [ = Function Reset
Both inputs 1 and 2 set to logic 1 for selec-

tions 8, A, B, B, E, &, B, B = Meter Reset

15




Press Menu Press Digit Press Value Select
> Select Key a9vd Select Key Al Key
000 O [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
(0 0 @ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 O [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O B Linear input
Nonlinear input scaling Custom curve linearization
Extended meter only.
00000 @ Unfiltered output
Filtering Alarm filtering Filtered output
00000 B Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 Bl Display batch average every 16 readings
Display filtering Display filtered signal
Bl Adaptive filter | Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 § Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
6 Moving average, 1.2 sec.
Moving average, 2.4 sec.
38 Moving average, 4.8 sec.
B Moving average, 9.6 sec.
A unfiltered
dEc.Pt d.dddd d.dddd@dd.dddgddd.dd@dddd.d@ddddd.
Dec. point selection | Decimal point flashes. | REBBI Press A to shift the decimal point.
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Press Menu
Select Key

Press Digit

MENU
Select Key

Press Value Select

o

Scaling method “Scale and Offset” if selected under Sj=i{ily

SCALE PXls Nellele BNeNlels | Select B thru [§ for flashing first digit, [§] thru g
Scale factor Xeloore [sXelolore iMoo | for other flashing digits. Select decimal point
Select digit to flash. location when decimal point is flashing.
PRlels [ONelelelel NeTelele | Select {E thru [ for flashing first digit, [§ thru
Offset value 0.0000H0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [ =GR

Scaling method “Coordinates of 2 points” if sel

ected under =%

0.0000
Low signal input.

Select digit to flash.

Select ¥ thru [§ for flashing first digit, [§] thru [g
for other flashing digits. Decimal point is set
by input range chosen.

Lo rd PRlels [ONelelele NeTelele | Select ¥ thru [ for flashing first digit, [§ thru
Desired reading at | [(feJoJols [SXeJelel0 for other flashing digits. Decimal point is set
Lo In. Select digit to flash. OYdEC.Pi

Hi In PXls) Nelelele BNeNlels | Select B thru [§ for flashing first digit, [§] thru g
High signal input. 0.0000§0.0000 for other flashing digits. Decimal point is set

Select digit to flash. by input range chosen.

PRlels [ONelelele NeTelele | Select { thru [ for flashing first digit, [§ thru
Desired reading at | [sXeolsle]e [Xelelele) for other flashing digits. Decimal point is set
Hi In. WAJEC.Pif

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under Sj={l]x

[y

o 1In
Low signal input.

i

Apply a low reference
signal to the meter.

Press A to store the low signal input in the
meter.

Apply a high reference
signal to the meter.

i In
igh signal input.

Ny T

Press A to store the high signal input in the
meter.

Lord 0.00000.00000.0000gR0.0000

Desired reading at | FXioJels SN0 Select ¥ thru [§ for flashing first digit, [§] thru g

Lo In. Select diait to flash. for other flashing digits. Decimal point is set
J \YAdEC.Ptif

0.0000[§0.0000[§0.0000§§6.7500

Desired reading at | GEeoe SO0 Select K thru g for flashing first digit, §] thru

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

QYdEC Pl
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [JIiIE Decimal point is set by S[=eHat.
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| 12. LOAD CELL & MICROVOLT INPUT - MODEL: VPI-LC I

The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to £20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (16),
analog output (17), communications (18), and transducer excitation output (19).

RANGE SELECTION VIA JUMPERS

. : b c
Ranges & Display with - -
Scale Factor =1 | H i
Full scale ' |

Input Jumpers display _-a d -

+20 mV e +20000 .

s50mvV | a +50000 e \
100 mV b +10000 I =
1250 mV c +25000 .
+500 mV d +50000

Notes 1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP

For DC microvolt meters, a scale factor of 1 and an offset of O are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 pV. The decimal point is set
separately.

For load cell applications, scaling is normally set up from the front panel using the P and A
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Please
see the Glossary for an explanation of each method.
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KEYSTROKES FOR VPI-LC SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
> Select Key

Press Digit
a9vd Select Key

Press Value Select
ReseT MG

Selection of signal
input type & range

!

Str
Strain or ratiometric

20, 50, 100, 250, 500 mV FS voltage

DC millivolts 20, 50, 100, 250, 500 mV FS voltage
SEtuP 00 00 [ 4-1/2 digit meter, counts by 1
Meter Setup Display type 5-digit remote display (£99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [l Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 [ 1 =Reset, 2 = Meter Hold
Rear connector control 1 = Function Reset 2 = Pk or Valley Disp.
inputs 1 & 2. 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 =Tare
tied to digital ground) 1=Peakor Valley 2=Tare
False = logic O (5V or 1= Tare _ 2=Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1, 2 =0, decimal point 1 = XXXX.X
1=0, 2 =1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1, 2 =0, decimal point 2 = XXX.XX
1=0, 2 =1, decimal point 2 = XX. XXX
1=1,2=1, decimal point 2 = X. XXX.X
B 1 = Function Reset 2 = Display Blank
® 1=Hold 2 = Display Blank
I 1= Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset

Both control insputs 1 & 2 setto 1 for selec-
tions @, B, A, /@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-

tions 8, M, B, B, E, &, B, @ = Meter Reset.
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Press Menu
Select Key

Mg

Press Digit
Select Key

Press Value Select

nal Key

000 0 @ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
000 0 @ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
[ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 0 @ Linear input
Nonlinear input scaling Custom curve linearization
Extended meter only.
@ Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 B Display batch average every 16 readings
Display filtering Display filtered signal
Adaptive filter |[] Low adaptive filter threshold level*
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
6 Moving average, 1.2 sec.
Moving average, 2.4 sec.
3 Moving average, 4.8 sec.
B Moving average, 9.6 sec.
g Unfiltered
dEc.Pt d.dddd

Dec. point selection

Decimal point flashes.
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Press Menu
Select Key

Press Digit

MENU
Select Key

Press Value Select

o

Scaling method “Scale and Offset” if selected under Sj=i{ily

SCALE PXls Nellele BNeNlels | Select B thru [§ for flashing first digit, [§] thru g
Scale factor Xeloore [sXelolore iMoo | for other flashing digits. Select decimal point
Select digit to flash. location when decimal point is flashing.
PRlels [ONelelelel NeTelele | Select {E thru [ for flashing first digit, [§ thru
Offset value 0.0000H0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [ =GR

Scaling method “Coordinates of 2 points” if sel

ected under =%

0.0000
Low signal input.

Select digit to flash.

Select ¥ thru [§ for flashing first digit, [§] thru [g
for other flashing digits. Decimal point is set
by input range chosen.

Lo rd PRlels [ONelelele NeTelele | Select ¥ thru [ for flashing first digit, [§ thru
Desired reading at | [(feJoJols [SXeJelel0 for other flashing digits. Decimal point is set
Lo In. Select digit to flash. OYdEC.Pi

Hi In PXls) Nelelele BNeNlels | Select B thru [§ for flashing first digit, [§] thru g
High signal input. 0.0000§0.0000 for other flashing digits. Decimal point is set

Select digit to flash. by input range chosen.

PRlels [ONelelele NeTelele | Select { thru [ for flashing first digit, [§ thru
Desired reading at | [sXeolsle]e [Xelelele) for other flashing digits. Decimal point is set
Hi In. WAJEC.Pif

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under Sj={l]x

[y

o 1In
Low signal input.

i

Apply a low reference
signal to the meter.

Press A to store the low signal input in the
meter.

Apply a high reference
signal to the meter.

i In
igh signal input.

Ny T

Press A to store the high signal input in the
meter.

Lord 0.00000.00000.0000gR0.0000

Desired reading at | FXioJels SN0 Select ¥ thru [§ for flashing first digit, [§] thru g

Lo In. Select diait to flash. for other flashing digits. Decimal point is set
J \YAdEC.Ptif

0.0000[§0.0000[§0.0000§§6.7500

Desired reading at | GEeoe SO0 Select K thru g for flashing first digit, §] thru

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

QYdEC Pl
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
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| 13. AC TRUE RMS VOLTS & AMPS INPUT I

AC voltage or current measurement utilizes the True
RMS signal conditioner board which uses precision
circuitry to compute the root-mean-square of complex
waveforms from 10 Hz to 10 kHz. Accurate measure-
ments are obtained with spikes up to 3 times the
maximum of each range. The input can be AC
coupled to read only the AC component, such as
ripple on a power supply, or DC coupled to read AC
plus DC. The board needs to be configured via
jumpers for the desired voltage or current range, and
for AC or DC coupling. All signal ranges are factory
calibrated with calibration factors stored in EEPROM.

i [T - "]

The meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. These need to be set manually. Please
see further manual sections for setup of the following features: relay output (16), analog output

(17), and communications (18).

Voltage Ranges

Full Scale Input | Counts | Jumpers

200 mV 20000 j
2V 20000 c,g,h
20V 20000 C,i
200V 20000 c, k
300V (UL) 3000 c,m
600V (not UL) 6000 c,m

Current Ranges

Full Scale Input | Counts | Jumpers

AC coupling for AC only none

w N

METER SCALING

2 mA 20000 I, k

20 mA 20000 b, m

200 mA 20000 a,m

5A 5000 c,d, e,m

AC or DC Coupling RANGE SELECTION VIA JUMPERS
Coupling Type Jumpers | 1 | etters indicate jumper position. Jumpers

DC coupling for AC + DC f are installed on pins adjacent to letters.
Use 2.5 mm (0.1") jumpers.
Store spare jumpers on unused jumper post.

Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
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can be set for direct readout in (milli)volts or (milli)amperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.

The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.

All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters.

INTERNAL SHIELD

To reduce noise pickup inside the meter or transmitter, the
RMS board is fitted with a flexible plug-on shield. If necessary,
This shield may be removed for jumper setting, but must be
reinstalled before closing the instrument.

SIGNAL SHIELDING

. L\ Sig High  RMS
(]
Signal Source Tl Sig Low  Board

____________________________________________________

Shield around twisted pair

— Earth Ground

Shielding for noise reduction

AC RMS measurements are susceptible to signal noise. This is especially true when the instru-
ment has a wide bandwidth. To minimize noise pickup, the input signal wiring should utilize a
shielded twisted pair, and the shield should be connected to signal low at the meter, as
illustrated. If signal low is close to earth ground, such as within 2V, signal low can further be
connected to earth ground at the meter, as illustrated.
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KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
> Select Key

Press Digit
a9vd Select Key

Press Value Select
nad Key

Selection of signal | Strain or ratiometric 0.2, 2, 20, 200, 660V FS
nputype & range
DC millivolts 2,20, 200 mA, 5A FS
SEtuP 00 00 B 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (x99,999)
scale factor of 1 ¥ 4-1/2 digits, counts by 10 (+20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00 00 [l 1 =Reset, 2 = Meter Hold
Rear connector inputs 1 = Function Reset 2 = Pk or Valley Disp.
1&2 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 =Tare
tied to digital ground) 1 =Peak or Valley 2=Tare
False = logic 0 (5V or 1= Tare _ 2=Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1, 2 =0, decimal point 1 = XXXX.X
1=0, 2 =1, decimal point 1 = XXX.XX
1=1, 2 =1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1, 2 =0, decimal point 2 = XXX.XX
1=0, 2 =1, decimal point 2 = XX. XXX
1=1, 2 =1, decimal point 2 = X.XXX.X
B 1 = Function Reset 2 = Display Blank
® 1=Hold 2 = Display Blank
1 = Peak or Valley 2 = Display Blank
[ 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset

Both control iguts 1 & 2 setto 1 for selec-
tions &, B, B}, /@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-

tions§, A, B, B, B, &, B, B = Meter Reset.
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Press Menu Press Digit Press Value Select
> Select Key a9vd Select Key pal Key
000 0 [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
00 O @ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 0 @ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O @ Linearinput
Nonlinear input scaling Custom curve linearization
Extended meter only.
00000 @ Unfiltered output
Filtering Alarm filtering Filtered output
00000 B Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every readings
Display filtering Display filtered signal
BNy Filtering for AC | Non-adaptive moving average filter
signal High-threshold adaptive moving avg filter
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
6 Moving average, 1.2 sec.
Moving average, 2.4 sec.
8 Moving average, 4.8 sec.
[ Moving average, 9.6 sec.
Unfiltered
dEc.Ptl L. dddd dlldd. dddffddd. doffidddd. dffddddd,
Dec. point selection | pecimal point flashes. .dddd
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Press Menu
Select Key

Press Digit

MENU
Select Key

Press Value Select

o

Scaling method “Scale and Offset” if selected under Sj=i{ily

SCALE PXlls) GNelelele NeNolels | Select B thru [§ for flashing first digit, [§ thru g
Scale factor Xellore [sXelelore iMoo | for other flashing digits. Select decimal point
Select digit to flash location when decimal point is flashing.
OROTelel ONelelelel NeTeleNe | Select ¥ thru B for flashing first digit, § thru [§
Offset value 0.0000H0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [¢]={6f.

Scaling method “Coordinates of 2 points” if sel

ected under =%

PRLlls) Nelelele XeNolels | Select B thru [g for flashing first digit, [§ thru g
Low signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PROTOlel) ONelelele NeTelelel | Select B thru ) for flashing first digit, § thru [§
Desired reading at | [ofeJoJe]s] OXeJolee for other flashing digits. Decimal point is set

Lo In. Select digit to flash. WYdEC.PH

Hi In PXlls) ONelelele [NeNolels | Select B thru [§ for flashing first digit, [§ thru [g

High signal input. 0.0000§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

OROJOlel ONelelelel NOTeleNel | Select ¥ thru ) for flashing first digit, § thru f§

Desired reading at | [sXelols]s) [eXelelele) for other flashing digits. Decimal point is set

Hi In. WAJEC.Pif

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under Sj={l]x

|

o 1In
Low signal input.

i

Apply a low reference
signal to the meter.

Press A to store the low signal input in the
meter.

Apply a high reference
signal to the meter.

i In
igh signal input.

Ny T

Press A to store the high signal input in the
meter.

Lord 0.00000.00000.0000gR0.0000

Desired reading at | SXeoJeYy] SXeIoLe0 Select ¥ thru [§ for flashing first digit, [§ thru g

Lo In. Select diait to flash. for other flashing digits. Decimal point is set
J WAJEC.Pif

0.0000§0.0000[0.0000§l§6.7500

Desired reading at | SRy PXeeloe Select K thru [§ for flashing first digit, § thru [g

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

by SIS
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [[JIlIEI. Decimal point is set by K]=olgt.
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| 14. THERMOCOUPLE INPUT - MODEL: VPI-MTC I

The thermocouple signal conditioner board used for temperature measurement can be confi-
gured via jumpers for 7 thermocouple types, each in a single range: J, K, T, E, N, S, R. The
meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. Display in °C or °F and resolution of 1°,
0.1° or 0.01° are user programmable. High resolution should only be used for relative readings,
not absolute readings. Although available, 0.01° resolution is not recommended for thermo-
couples. Offset adjustment is available for thermocouples and is normally set to 0000.0. If °C is
selected, entering an offset of 0273.2 will change the display to Kelvin. If °F is selected,
entering an offset of 0459.7 will change the display to Rankin.

The addition of a relay output board turns the thermocouple meter from a temperature indicator
into an on/off temperature controller. Please see further manual sections for setup of the
following features: relay output (Section 16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

Type E4 Jumper %] ~:-
J,K,E,N none 1y

T, R, S ]

Open Indication E3 Jumper

Upscale h

Downscale [

E4
Letters indicate jumper position.

Jumpers are installed on pins adjacent to letters.
Use 2.5 mm (0.1") jumpers.

Store spare jumpers on an unused jumper post.

E3

PwpnPRE
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KEYSTROKES FOR VPI-MTC SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
> Select Key

Selection of signal
input type & range

SEtuP
Meter Setup

Press Digit Press Value Select
a9vd Select Key ReseT MG
J°F B J°C BRI ENANIe
Thermocouple K °F K °C Type K, °F or °C
n °F n °C Type N, °F or °C
E °F =3®] TypeE, °For°C
t °F e Type T, °For°C
S °F SO Type S, °For°C
r °F r °C Type R, °F or °C
00 00 [ 0.1 degree resolution
Display selection. Remote display (£99,999)
0.01 degree resolution
1 degree resolution
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 @ Offset only for thermocouple input.
Scaling method
00 00 [ 1=Reset, 2 = Meter Hold
ontrol inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic 0 (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1 = Tare, 2 = Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1,2=0, decimal point 1 = XXXX.X
1=0, 2 =1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1, 2 =0, decimal point 2 = XXX.XX
1=0, 2 =1, decimal point 2 = XX. XXX
1=1,2=1, decimal point 2 = X.XXX.X
B 1 =Function Reset 2 = Display Blank
® 1 =Hold 2 = Display Blank
A 1 =Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1="Tare 2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selec-
tions @, A1, Iy, é): Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
tions @, fl. B, B, B, &, B, ® = Meter Reset.
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Press Menu Press Digit Press Value Select
> Select Key a9vd Select Key Al Key
000 0 @ No used.
Meter Configuration : .
'gurat 00 0 @ Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at rear connector.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at rear connector.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
00000 [ Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 [ Display batch average every 16 readings
Display filtering Display filtered signal
BRI Adaptive filter |8 Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
& Moving average, 9.6 sec. Unfiltered
OFFst OXONlle ONollele SMoole | Select B thru [§ for flashing first digit, § thru §
Offset value 0.000080.0000 for other flashing digits. Use offset for display
Select digit to flash. in Rankine or Kelvin.

Option board dependent menu items

Menu items related to alarm setup if a relay board is detected. Please see Section16.

Menu items related to analog output if detected. Please see Section 17.

Menu items related to serial communications if detected. Please see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) menu items. Please see Section 9.

32




| 15. RTD & RESISTANCE INPUT I

RTD and resistance measurement can be configured via jumpers for four RTD types (DIN
platinum, ANSI 100Q platinum, 120Q nickel, 10Q copper) or five resistance ranges (from
20.000Q to 200.00 kQ). All ranges are factory calibrated with calibration factors stored in
EEPROM on the signal conditioner board. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
With RTDs, display in °C or °F and resolution of 1°, 0.1° or 0.01° are user programmable.

Please see further manual sections for setup of the following features: relay output (Section
16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

RTD Type or Ohms E1 Jumper . o o
Pt100, Ni120 a E1/h § ¢
Cul0,20Q b g Q C.>
200 Q c

2000 Q d E2 E

20000 Q e

200 kQ f

Connection E2 Jumper

2 or 4 wire none

3 wire g

1. Letters indicate jumper position. Jumpers are installed on pins adjacent to letters.
2. Store spare jumpers on an unused jumper post.

SCALE & OFFSET SETUP

Scale is normally set to 1.0000. Scale can be used as an RTD correction when actual
resistance is other than nominal, as stated on the RTD calibration sheet. For a Pt100 RTD,
divide 100 by the stated resistance at 0°C. For example, for a 99.04 ohm RTD, scale should be
set to 100/ 99.04 = 1.0097.

SIGNAL SHIELDING

Shielding for noise reduction

200 kQ ranges and above measurements are susceptible to signal noise. To minimize noise
pickup, the input signal wiring should utilize a shielded twisted pair and the shield should be
connected to signal low and earth ground at the meter, as illustrated. Use 2-wire hookup
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RTD & RESISTANCE CONNECTION

With the appropriate jumper settings, RTD
and resistance measurements allow 2, 3 or 4-

_ -Excitation | 1
wire RTD hookup to the J5 connector, as +Exctation | 2 T
illustrated. The meter applies a fixed excita- -Signal input [ 3 | |
tion current. +Signalinput | 4

In 4-wire hookup, lead resistance is not a
factor, since different pairs of wires are used
for excitation and sensing.

In 3-wire hookup, the meter automatically -Excitation | 1 —
compensates for lead resistance by measur- +Excitation | 2 R |:|
ing the voltage drop in one current-carrying -Signal input | 3 .
lead and assuming that the voltage drop in +Signal input | 4

the other current-carrying lead is the same.

In 2-wire hookup, the meter senses the
voltage drop across the load and both lead
wires. The effect of the lead wires can be

) -Excitation | 1 —
measured and subtracted by shorting out the +Excitation | 2 ._‘
load during meter setup. The short should be -Signal input | 3 |:|
as close as possible to the load. Ambient +Signal input | 4 |

temperature changes will still cause some
error in the readings -- the higher the lead
resistance, the greater the error.

4-wire RTD or resistance

3-wire RTD or resistance

2-wire RTD or resistance

To eliminate lead wire resistance, follow this procedure:

1. Set the InPut menu item and jumpers for the desired range

. Set COnFG to (eje]oxMA.

2
3. Short the two leads at the sensor end.
4

. When the display has settled, push the > key. The meter will then store a value propor-

tional to lead resistance, automatically change COnFG to [8[8je}ly), and then reset. The same
result is obtained by grounding a Control Input that has been selected for Peak or Valley
(SEtuP [o[sl8Nd, where Y =1, 2,4, A, C).

Remove the short and connect the sensor. The meter now processes the sensor resistance
only.

If the range and associated jumpers are subsequently changed, the above procedure must be
repeated. This procedure is also available through Instrument Setup software, Revision 2.7.0
or later.
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KEYSTROKES FOR SETUP

If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu
> Select Key

Press Digit
794 Select Key

Press Value Select
nxai Key

Pt100 RTD, DIN alpha .00385, °F
Selection of signal | RTD Pt100 RTD, DIN alpha .00385, °C
Input type & range Pt100 RTD, ANSI alpha .003902, °F
Pt100 RTD, ANSI alpha .003902, °C
Ni120 RTD, alpha .00672, °F
Ni120 RTD, alpha .00672, °C
Cul0 RTD, alpha .00427, °F
Cul0 RTD, alpha .00427, °C
0 to 20 ohms
Ohmmeter 0 to 200 ohms
0 to 2000 ohms
0 to 20000 ohms
pdo[oNele) O to 200.00 kohm
SEtuP 00 00 B 0.1° RTD or 4-1/2 digits for ohms
Meter Setup Display selection with 5-digit remote display (x99,999)
scale factor of 1. 0.01° RTD, 4-1/2 digit ohms count by 10
1° RTD or 3-1/2 digits for ohms
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 B Scale and offset method (RTD & ohms)
Scaling method Coordinates of 2 points (ohms)
Reading coordinates of 2 points (ohms)
00 00 [ 1=Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic 0 (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1 = Tare, 2 = Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1, 2 =0, decimal point 1 = XXXX.X
1=0, 2 =1, decimal point 1 = XXX.XX
1=1,2=1, decimal point 1 = XX. XXX
1=0, 2 =0, decimal point 2 = XXXX.X
1=1, 2 =0, decimal point 2 = XXX.XX
1=0, 2 =1, decimal point 2 = XX. XXX
1=1,2=1, decimal point 2 = X.XXX.X
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Press Menu
> Select Key

Press Digit
a4 Select Key

/\ Press Value Select

N3ad Key
SEtuP 00 00 B 1 =Function Reset 2 = Display Blank
Meter Setup Control inputs 1 & 2 ® 1=Hold 2 = Display Blank
(continued) (continued) I 1 = Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selec-
tions @, B, A, /@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
tions @, fl. B, B, B, &, B, ® = Meter Reset.
Operation as a | § Not rate of change B Rate x 10

Meter Configuration

rate of change meter.
Extended meter only.

Rate x 1000
B Rate x 10000

Rate x 0.1
Rate x 1

00000 @ Peak Display. Also selects “Peak” in

Operation of front “Peak or Valley” at connector above.

panel PEAK button Valley Display. Also selects “Valley” in

and rear connector for “Peak or Valley” at connector above.

Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare

00000 @ No auto-tare

Auto-tare selection Auto-tare

00000 RTD Ohms

RTD or Ohms wiring Bl 3 or 4 wire 3 or 4 wire
Not allowed Custom curve
2-wire read 2-wire read
2-wire short 2-wire short

00000 @ Unfiltered output
Filtering Alarm filtering Filtered output

00000 @ Unfiltered Peak & Valley

Peak & Valley filtering Filtered Peak & Valley

00000 B Display batch average every 16 readings

Display filtering Display filtered signal

BRI Adaptive filter |8 Low adaptive filter threshold level

threshold High adaptive filter threshold level
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Press Menu Press Digit Press Value Select
> Select Key a4 Select Key Al Key
00000 B Autofilter
Filtering Input signal filtering. Batch average, 16 readings
(continued) Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
9 Moving average, 9.6 sec.
A Unfiltered
d.dddd d.dddofldd.dddllddd. ddfidddd, dffddddd,
Decimal point Decimal point flashes
) .ddddd
selection if ohms are selected -
under
SCALE OXOLNs ONJlle SMoIlle | Select [ thru [§ for flashing first digit, § thru
Scale factor AXelolole [sMelolore iMooy | for other flashing digits. Select decimal point
— S location when decimal point is flashing.
Select digit to flash.
OXONlle ONOlele SMoole | Select B thru [§ for flashing first digit, § thru §
Offset value 0.000000.0000 for other flashing digits. Use offset for display
Select diait to flash. in Rankine or Kelvin. Decimal point location
J is selected by [s]SeH .

Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
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| 16. DUAL OR QUAD RELAY OUTPUT OPTION I

An optional relay board may be installed in the
meter main board at plug position P2, adjacent to
the power supply board. Four board versions are
available: 2 or 4 relays, mechanical or solid state.
Once installed, the relay board is recognized by
the meter software or PC-based Instrument Setup
software, which will bring up the appropriate menu
items for the type of board. These menu items will
not be brought up if no relay board is detected.
Menu selections for relays 3 and 4 will not be
brought up if the dual relay board is detected. All relay boards offer a choice of operating
modes: normally off or on, latched or non-latched, hysteresis band, deviation band, alarm
based on the filtered or unfiltered signal, and selectable number of readings in alarm zone to
cause an alarm.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

The < (Alarms) key can be used to step through and view setpoints while the meter continues
to make conversions and performs setpoint control. If the > (Peak) key is pressed while a
setpoint is displayed, conversion stops and the setpoint can be changed. After pressing <, you
have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Loc3, digit 2, must have been set to 0. To change setpoints, menu item Loc2, digit 2, must
have been set to 0.

MER Press Digit

,q[_ﬁqs Alarms Key Select Key RESET Ere(;ss Ve @ SElee
300.24 200.00 295.00
Press < (Alarms) Current setpoint 1 value blinks, and To change setpoint 1 value,
to display Alarm 1 Alarm 1 LED indicator lights. Press > | press A to change selected
setpoint. to select a digit, which will blink. blinking digits.
395.00 395.00 305.00
Press < (Alarms) Current setpoint 2 value blinks, and To change setpoint 2 value,
to display Alarm 2 Alarm 2 LED indicator lights. Press > | press A to change selected
setpoint. to select a digit, which will blink. blinking digits.
395.00 395.00 305.00
Press < (Alarms) Current setpoint 3 value blinks, and To change setpoint 3 value,
to display Alarm 3 Alarm 3 LED indicator lights. Press > | press A to change selected
setpoint. to select a digit, which will blink. blinking digits.
395.00 395.00 305.00
Press < (Alarms) Current setpoint 4 value blinks, and To change setpoint 4 value,
to display Alarm 4 Alarm 4 LED indicator lights. Press > | press A to change selected
setpoint. to select a digit, which will blink. blinking digits.
g% Press < (Alarms) again. Meter will reset and display current reading.
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KEYSTROKES FOR SETPOINT SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

gress Menu Press Digit Press Value Select
elect Key a9vd Select Key RESETINONY
B Relay 1on Relay 2 on
Alarm Setup for Relay state when Relay 1 off Relay 2 on
relays 1 & 2 if alarm is active. Relay 1 on Relay 2 off
detected. Relay 1 off Relay 2 off
Press > until ALSEt B Alarm 1 auto reset Alarm 2 auto reset
is displayed. Alarm latching or non- Alarm 1 latching Alarm 2 auto reset
latching (auto reset). Alarm 1 auto reset Alarm 2 latching
Alarm 1 latching Alarm 2 latching
[ AL1 active high AL2 active high
Alarm operates at and AL1 active low AL2 active high
above setpoint (active AL1 disabled AL2 active high
high) or at and below AL1 active high AL2 active low
setpoint (active low). AL1 active low AL2 active low
AL1 disabled AL2 active low
B AL1 active high AL2 disabled
AL1 active low AL2 disabled
B AL1 disabled AL2 disabled
Bl AL1 band deviation AL2 band deviation
Hysteresis mode or AL1 split hysteresis AL2 band deviation
band deviation mode AL1 band deviation AL2 split hysteresis
AL1 split hysteresis AL2 split hysteresis
No deviation or hysteresis in menu.
AL1 span hysteresis AL2 band deviation
B AL1 span hysteresis AL2 split hysteresis
AL1 span hysteresis AL2 span hysteresis
[ After 1 reading After 16 readings
Number of consecutive After 2 readings After 32 readings
readings in alarm zone After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
[ Relay 3 on Relay 4 on
Alarm Setup for Relay state when Relay 3 off Relay 4 on
relays 3 & 4 if alarm is active. Relay 3 on Relay 4 off
detected. Relay 3 off Relay 4 off
[ Alarm 3 auto reset Alarm 4 auto reset
Alarm latching or non- Alarm 3 latching Alarm 4 auto reset
latching (auto reset). Alarm 3 auto reset  Alarm 4 latching
Alarm 3 latching Alarm 4 latching
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Press Menu
> Select Key

Press Digit
94 Select Key

Press Value Select

a1 Key

A

ALS34

Alarm Setup for

relays 3 & 4
(continued)

00000

Alarm operates at and
above setpoint (active
high) or at and below
setpoint (active low).

AL3 active high
AL3 active low
AL3 disabled
AL3 active high
AL3 active low
AL3 disabled

AL4 active high
AL4 active high
AL4 active high
AL4 active low
AL4 active low
AL4 active low

AL3 active high AL4 disabled
AL3 active low AL4 disabled
AL3 disabled AL4 disabled

Hysteresis mode or
band deviation mode
(see Glossary)

AL3 band deviation AL4 band deviation
AL3 hysteresis AL4 band deviation
AL3 band deviation AL4 hysteresis
AL3 hysteresis AL4 hysteresis

(0[N |- O RRICO N[O O] [W N =[O

Number of consecutive
readings in alarm zone
to cause an alarm.

After 1 reading

After 2 readings
After 4 readings
After 8 readings

After 16 readings
After 32 readings
After 64 readings
After 128 reading

100 1N [ (O]
| SN Y

dEU1H PRLlls) [ONlelelsl BMJoleld | Select ¥ thru [§ for flashing first digit, [§ thru g
Alarm 1 0.0000H0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEU2H
entered.
Alarm 2
hysteresis
DEU1b ORJlls) [ololelsl BMJolel) | Select B thru [§ for flashing first digit, [§ thru g
Alarm 1 band 0.0000M0.0000 for other flashing digits. Alarms will activate
deviation Select digit to flash. above and below the setpoint by the value
entered and will deactivate in the middle of
DEU2D the band.
Alarm 2 band
deviation
dEU3H OROLOlele [eTeleel BMeJlls | Select B thru [ for flashing first digit, [§] thru §
Alarm 3 0.0000[0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEU4H
entered.
Alarm 4
hysteresis
DEU3b PRLlls) [ONlelels BMJoleld | Select B thru [§ for flashing first digit, [§ thru g
0.0000§0.0000 for other flashing digits. Alarms will activate

sl 2 >
29
23
=l & w
S o

)

>

o

EU4
Alarm 4 band
deviation

Select digit to flash.

above and below the setpoint by the value
entered and will deactivate in the middle of
the band.
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| 17. ANALOG OUTPUT OPTION I

An optional analog board may be installed in the meter at rear panel jack position J4, adjacent
to the signal conditioner board. Once installed, this board is recognized by the meter, which
will bring up the appropriate menu items for it. These will not be brought up if an analog output
board is not installed.

The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line.
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is
selected at the connector. Unipolar 4-20 mA or 0-20 mA current is selected in software.

UNIPOLAR CONNECTIONS

4-20 mA or 0-20 mMAQUTPUT 1| [am

0-10V OUTPUT 2| I

ISOLATED GROUND 3| I
BIPOLAR CONNECTIONS

REFERENCE or RETURN 1| [im

-10V to +10V OUTPUT 2| @I

N/C 3 I

Unipolar current of voltage: Jumper a
Bipolar -10 to +10 voltage: Jumper b

The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low
displayed reading An Lo. The high analog output (20 mA, OV or 10V) may be set to corres-
pond to any high displayed reading An Hi. The meter will then apply a straight line fit between
these two end points to provide an analog output scaled to the meter reading.

KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Select Press Value Select
> Select Key 7Ive Key reseT BV

[ 00 [ 0-20 mA current output

Analog Output Setup. | Analog output signal 0-10V voltage output

Press > until AnSEt is | selection. 4-20 mA current output

displayed (requires -10 to +10V voltage output

I tput board). :

analog output board) [ 00 [ Analog output unfiltered
Analog output filtering. Analog output filtered

0.0000[§0.0000[0.0000 Select ¥ thru ] for flashing first

Low displayed value 0.000080.0000 digit, @ thru @ for other flashing

for 0 mA, 4 mA, OV, or | gglect digit to flash. digits. Decimal point location is

-10V output fixed by selection.

0.0000j0.0000f0.0000 Select B thru [§ for flashing first

High displayed value | fXelonle XeIeLel digit, [§ thru [§] for other flashing

for 20 mA or 10V out- | gglect digit to flash. digits. Decimal point location is

put fixed by selection.
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| 18. SERIAL COMMUNICATION OPTIONS I

A serial communications board may be connected to the meter main board at plug position
P3 (middle position). Available boards are RS232, RS485 (with dual RJ11 connectors), RS485
Modbus (with dual RJ45 connectors), USB, USB-t0-RS485 converter, Ethernet, and Ethernet-
t0-RS485 converter. The dual connectors of RS485 boards are wired in parallel to allow daisy
chaining of addressable meters without use of a hub. Three serial communication protocols
are selectable for all serial boards: Custom ASCII, Modbus RTU, and Modbus ASCII.

A USB-t0-RS485 converter board or an Ethernet-to-RS485 converter board allows a meter
to be interfaced to a computer and be the device server for a network of up to 31 other meters
on an RS485 bus, while itself retaining all capabilities of a meter. The remote meters need to
be equipped with our RS485 digital interface board with dual 6-pin RJ11 jacks, not our RS485
digital interface with dual 8-pin RJ45 jacks. The dual 6-pin RJ11 jacks on the RS485 board are
wired in parallel to allow multiple meters to be daisy-chained using readily-available 6-wire
data cables with no need for hand-wiring or an RS485 hub. The outer two wires are used for
ground.

Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables,
all the way from the device server to the last device on the RS485 bus. Connect ATX to ATX,
BTX to BTX, etc., with no crossover as you go from device to device.

To connect a meter with a USB board to a computer, use a USB cable with Type A and
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD.
When the installation is complete, use Device Manager to determine the com port. To get to
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab,
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and
USB serial port (com #). Note the com port # for use with communications to your meter, then
exit Control Panel. If you later need to change the Com port, right-click on USB serial port
(com #), then on Properties, Port settings, and Advanced. Change port to the desired number,
click OK, then exit Control Panel.

To connect a meter with an Ethernet board to a computer, see our separate Ethernet
Manual, which covers our Node Manager Software. This Windows-based application runs on a
host computer and is used to configure our Ethernet Nodes. It automatically discovers all
Nodes on a LAN or WAN, plus any devices connected to Server Nodes via an RS485 bus. It is
used to configure each Node, such as setting communication parameters, naming the Node
and associated devices, entering email addresses for alarm notification and data requests,
selecting the Node's time zone for time-stamping of emails and streaming data, and upgrading
firmware. Once configuration data has been stored in flash memory of all Nodes, Node
Manager Software can be closed.

BOARD SETUP VIA JUMPERS

USB Board
No jumpers required.
USB
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Basic Ethernet Board
No jumpers needed.

Ethernet
RS232 Board
e - Normal operation.
f - Slave display to RS232 from another meter.
g - Pull-up resistor on RTS line.
Note: Board is shipped with jumpers e and g installed RS-232 memfmgm

RS485 Board, Full Duplex Operation

b & d - Installed on last meter in long cable run.
RS485 Board, Half Duplex Operation

a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

mam ubecCundn

RS-485

RS485-Modbus Board, Full Duplex Operation

b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.

RS485-Modbus Board, Half Duplex Operation

b & e - bias jumpers installed on 1 board.
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

Modbus

Ethernet-to-RS485 Converter Board
& USB-t0-RS485 Converter Board

Full Duplex Operation

No jumpers for short cable runs.
Add b & d for long cable runs.

Half Duplex Operation

a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Ethernet-to-RS485
mam mbecu nds

USB/RS485
mdm ubuCundn
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SERIAL CONNECTION EXAMPLES

NSBSSY

EAREE "

Meter with Ethernet, USB, or
R&232 serial interface board

Host computer

RS485 hub via RJ11 connectors
Ethernet or USB cable and 6-wire data cables

R&485 RS485

b g ke e b e b b b b g b e

TEMNDE T GHRE ' EREE T

Meter with RS485 server Meters with RS485 |/O boards,
board, Ethernet-to-serial each with two RJ11 connectors
or USB-to-serial

Host computer

Ethernet cable 9949g9g9g9
IR
Ethernet cable
Route_:r Meter with Ethernet
or switch [/O board with RJ45.

9 9 99 9 9 Meter with Ethernet-
RS485 |Ry11 EERIRIRIEEE to-scrial server board.
RJ45 to Ethernet.
RJ11 to RS485 bus.

Daisy-chained RJ11 999999

6-wire data S o
cables [Ru11 e

Meters with RS485
I/O boards, each with

rsass RV BEEEEEER  two RJ11's for daisy-
ENFIRIREEE chained RS485

Host computer
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Ethernet

Internet &
modems

Router Ethernet-to-

serial server

Router

e &

Host
computer

Transmitters

KEYSTROKES FOR SETUP
If the MENU B=® key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Select Press Value Select
> Select Key aavd Key ReseT MG

| 000 [ Send unfiltered signal

Fixed Parameters: | Output filtering Send filtered signal

B oo bhs 000 @ 300 baud

1 stop bit Baud rate 600 baud
1200 baud
2400 baud
4800 baud
9600 baud
B 19200 baud

| 000] 60 Hz 50 Hz
Output update rate [ Line frequency Line frequency

0.28 sec 0.34 sec
0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
4.5 sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
B 36.6 sec 43.5 sec
[ 72.5sec 97 sec
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Press Menu
> Select Key

Press Digit Select
274 Key

Press Value Select
Rl

a1 Key
| 0000 @ No line feed after carriage return
Serial Setup 2 Line feed Line feed after carriage return
0000 @ No alarm data
Alarm data with readings Alarm data with reading
0000 @ Continuous data output
Control of data output Data output on ASCIl command only
0000 Select @l thru [§ for addresses 1 thru 15.
Meter address with Custom | Select {08 thru [@ (with decimal point) for

ASCII protocol

addresses 16 thru 31.

00000 @ Full duplex
Serial Setup 3 Half or full duplex Half duplex
00000 [ Standard continuous mode
Special start & stop char. Special start & stop characters
00000 @ Normal RTS
RTS mode Single transmission
00000 @ Only at end of all items
Termination characters At end of each item
00000 [ Reading
Serial Setup 3 Data sent in continuous Peak
(continued) mode Valley
Reading + peak
Reading + valley
Reading + peak + valley
SEr 4 | 000 B 1sec
Serial Setup 4. Modbus ASCII gap timeout 3 sec
5 sec
10 sec
| 000 @ Custom ASCII
Serial protocol Modbus RTU
Modbus ASCII
| 000 [ None, 2 or more stop bits
Parity Odd, 1 or more stop bits
Even, 1 or more stop bits

Modbus Address.
Appears only if the
Modbus protocol is
selected.

Select digit to flash.

!

24
Select § through [ for flashing digit.
Address range is 1 to 247.
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| 19. EXCITATION OUTPUT & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (85-264 Vac) and to the low voltage power
supply (12-32 Vac or 10-48 Vdc).

Excitation output Jumper locations
b d e
5 Vdc +5%, 100 mA max b,d, e E R R B E RN
0 b d f
10 Vdc +5%, 120 mA max b,d,f EEEE EBEEBHE

24 VVdc 5%, 50 mA max C c
H EE R E 8 H

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. (See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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20. INSTRUMENT SETUP VIA PC

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download 1S2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.
2) Meter to be set up.

3) RS232 board in the meter. This board can be ]
used for meter setup, then be removed. s 2 A
4) RJ11-to-DB9 RS232 cable to connect the meter G
and PC (see Section 1, Ordering Guide). RJ11-to.DBY RS.237 cable

5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => IS2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.
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=0 x|

Relay Alarms | C icati { Analog Dut T Lockouts

Input+Display Scaling Filter

InputsDisplay|__ Scaling | Filter | Relay Alarms | C ication Analog Out | Lockouts ~Alarm 1 - Alarm 2
O BASIC Option Sig Cond Option Relay Dption Comm Option Analog Dption Seipoint 1 Seipoint 2
® EXTENDED Boards ’7 ’]Relay Board ] “REZaZ Board T‘ “Nnne j—‘ ’7\ *‘31“”"“-“‘ ’V| +020000 7‘
Deviation 1 Deviation 2
r Signal Input. “ +000000. “‘ “ +000000. j
Mode Range Custom Curve Rate 50/60 Hz Line Freq‘ FYTE— Alatm 2 Source
“DE v =l ’] 0.2v =l ’]Disahled j—‘ “Disahled =l ’V|5n Hz j‘ “Fﬂmnd J—‘ “med JT
~Display Alarm 1 State Alarm 2 State
Resolution Display Filter Decimal Point Peak Button Action - Auto Tare “ High Active j—‘ “ High Active v
’]4. 5 Digits j‘ ’]Filtered ] ’Vddddd J—‘ ’VFeak J‘H’IDlsabled ﬂ Relayl Alrmn State Relay2 Alrm State
“ Active On 7| [ [aciveon =]
Deviation 1 Type Deviation 2 Type
“ Band Deviat'n 7 | [ | Band Deviar'n ¥
r Control Inputs Alarm 1 Type Alarm 2 Type
Control Tnpuk A —----——--—- Control Input B —-----——--—-—— Both Ctrl A, B
’VIMeter Reset Meter Hold Cold Reset j‘ “ Nnn—Lam]dng] “ Nnn—l..au:lu'ngj
Alarms 1.2 No.Rigs to Alarm
{ 1 Reading T [~ Mo Deviation in Menu
Main Menu | Main Menu

SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

e The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading O’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

2900. L | e —————--—""——————
2875,

LT B R e T T
2850.
2825, FI I D | D
2800,

B12 J-mmmmeee oo R - B - oo
2775,
2750

17 ———— 1 1 ] 111 1T
2725,
2700 1]

] _ _ i : _ _ _ i 2725. 2750. 2775. 2800. 2825. 2850. 2875.
Print Save Pause | Continue | New Scale End Print Save | Pause | Continue | New Scale End
Plot Graph

49




e The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

e The Jumpers pull-down menu provides
jumper positions for the various meter boards,
duplicating information in this manual.

&, DC Signal Conditioner Calibration

Select Range
Zero -

e The Calibration puII-down menu allows Scale Factorsetia 10|,

easy calibration of voltage and current ranges | galib [Desied | Curent Curent | New | New
for the DC, load cell, and AC RMS signal [ovbc o | -0 FFFa_| FFDG_| 0003 0
conditioner boards. The PC first recognizes oo Fres | Fres | onon 3
the type of board, then prompts you to apply 5 |
specific jumpers and calibration signals. Press =
Ready to take a reading. Press Repeat to take —
more readings. When you have decided on =B
which reading to accept, press on the number _son |
1 through 10 of that reading. Additional cali-
bration software is available online. MENUKEY |S |1 |2 |3 |4 |5
InPut d C v
METER SETUP WITH AN UNCONNECTED PC SEtuP 0 0D 0O 0 O
Instrument Setup software is also of benefit when the |SGRFG o0 /000
PC is not connected to a meter. Upon launching the Fil tEr 010/1]1]6
software, click on None for Communications, then on |-2ecPt djdjd.jd|d
DPM and Series 2. Click on File => Default Setup to SCALE o /o010
retrieve a default setup file from disk, or on File => Open OFFSt 0/0]0.]00
Setup to retrieve a previously saved setup file from disk. SEr 1 015 |0
SEr 2 0 0 1 1
To enter new setup information, click on View => Setup, | Loc1 0 0 0 0 O
then make your screen selections as if you were | Loc2 00 1 0
connected to a meter. Tabs will be grayed out if you | Loc3 0 0 0 O
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under

Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
> key, and the seven data columns correspond to values entered via the > and A keys.

Click on any step in the sequence to bring up a detailed help window.

Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.

Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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21. CUSTOM CURVE LINEARIZATION

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curve-

fitting algorithm uses quadratic segments of

varying length and curvature, and provides

diagnostics to estimate curve fitting errors.

The program is self-prompting, avoiding the

need for a detailed printed manual. This

manual section is only intended as an intro-

duction and get-started guide.

PREREQUISITES
1) PC-compatible computer with an available Com 1 or Com 2 RS232 port.
2) Extended meter.

3) An RS232 board in the meter. This board can be
used for meter setup only, then be removed. = ;
4) An RJ11-to-DB9 RS232 cable to connect the s o UDGDU Duﬁ
meter and PC (see Section 1, Ordering Guide). &

5) Curve. ft downloadable from the web
) aturr]\c/)ecﬁzfgzg. ware (downloadable from the we RJ11-t0-DBY RS-232 cable

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the > key to get to FJ=gHl, then
set the entry to 8. Set the meter address to 1. To do so, press the > key to get to
B, then set the entry to [JeFEl. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.

You will be given the choice to enter your data in one of four modes:

1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.

2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1IX*"P1 + K2X"P2 +
K3*X"P3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.

You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter O and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.

Position of the decimal point from 6=X.XXXXX, 5= XX. XXX, 4=XXX. XXX, 3=XXXX.XX,
2=XXXXX. X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the > key to get to [SfiIm€ then set the fifth digit to either [§
(normal linear operation) or to M (custom curve operation). This fifth digit will only be
displayed with an Extended meter.

FILES USED OR CREATED BY CURVE.EXE
1) *RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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| 22. METER CALIBRATION I

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibra-
tion, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.
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| 23. SPECIFICATIONS |

Meter Display

TYPE oo 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
0] o ] RS Red or green
= 1 o = -99999 to +99999 and -99990 to +99990
A to D Conversion
Read RAE ........uuuiiiiiiiiiiiii 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update RAte ........coeuuiiiiiiieiiiiieiiiiie et 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate .......ccooeeeiiiieeiiiiee e 3.5/s at 60 Hz, 3/s at 50 Hz
Noise Rejection
CMV from DC t0 B0 HZ......iiiieeiciee e Withstand 250Vac
Dielectric strength...........ccoooieiiiiiiiiiii e, 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMR from DC 10 60 HZ ... e 130 dB
NMR at 50/60 HZ......covveiiiiie e 90 dB with minimum digital filtering
Control Inputs (CMOS/TTL levels, logic O = tied to digital ground, logic 1 = open)
= (o] o T T | S Logic 0 holds display and outputs
[ Peak or Valley iNput ........cooiiiiiiiiiiic e Logic 0 displays peak/valley value
1= 1= o o1 | R Logic 0 offsets input value to zero
[ TAre RESEL .. Logic O resets Tare value to zero
= T = T o | S Logic 0 resets all meter functions
/ Function ReSet INPUL .......oviiiiiiiiiiiiiiei e Logic O resets peak values and alarms
/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
/ Display Blank iNPUL............ooeiiiiiiiiiiiiiiiiieiieeieeeeeeeeeeeeeeeeeeeeeeeeeeee Logic 0 shuts off the display
Power Requirements
Input Voltage rating (standard)......... 85-264 Vac or 90-300 Vdc (DC range not UL approved)
Input Voltage rating (low voltage option) .............ccceeeevieeeieeeeeiiiiieenn. 12-32 Vac or 10-48 Vdc
POWET LiNE FIEOUEINCY ....evveeiieeiiiieiiiieteeteeeeeeeeteeseeeeeeeseseeseeeseseseeeessneeeseesenenees DC and 47-63 Hz
Power CoNSUMPLION, MAX ......cooiiiiiiiiiiii i eee e e e e e e e e e e e e e e e e e e e e eeeeeeanes 5 Watts

Excitation Outputs

Voltage & Current Levels (jumper selectable) ..........ccccoooeeiiiiiiiinnnnn. 5 Vdc £5%, 100 mA max
10 Vdc £5%, 120 mA max
24 Vdc £ 5%, 40 mA max

EXcitation OULPUL RIPPIE .. .coieeeeeeiee e e e e e e 100 mVp max
Isolation from power and OULPULS .........uuiiieie i 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to SIgNal COMMON ...t e e e e e eeeaeees 50 Vdc
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Input Types, Ranges, Resolution, Error at 25°C

DC Volts Thermocouple (0.1°, 1° resolution)
Range Resol. |Resistance | Error Type Range Error
200.00 mV | 10 pVv 1GQ 3 -210to 760°C |.01% FS +0.09°C
2.0000V | 100 pv 1GQ 0.01% -347to 1400°F |.01% FS +0.16°F
20000V 1mV - 10MQ ) of FS -244 t0 1372°C | .01% FS 0.10°C
200.00 V 10 mV 10 MQ +2 cts K
3000V 100 mV 10 MO -408to 2501°F |.01% FS +0.17°F
0 to 400°C .01% FS +0.03°C
DC Amps . -2571t0 0°C  |.01% FS +0.20°C
Range Resol. |Resistance| Error 32to 752°F |.01% FS #+0.05°F
-430 to 32°F |.01% FS +0.36°F
2.0000mA | 0.1 pA 100 Q 0.01%
20.000 mA 1 pA 100 IO E -240 to 1000°C |.01% FS +0.18°C
200.00 mA | 10 pA 10 f; lc:;tss -400 to 1830°F | .01% FS £0.32°F
5000A | 1mA | 0010 |~ y | -2451t01300°C | 01% FS 0.10°C
-410 to 2370°F | .01% FS £0.17°F
True RMS Volts (0% to 100% of Full Scale,
0 Hz and 10 Hz to 10 kHz, crest factor 3.0) S -46 t0 +1768°C |.01% FS +£0.12°C
-51 to +3213°F | .01% FS +0.22°F
Range Resol. [ Resistance | Error
R -45t0 1768°C |.01% FS +0.17°C
200.00 mV | 10 pVv 22 MQ -49 to 3214°F |.01% FS +£0.31°F
2.0000V | 100 pv 22 MQ 0.1%
20.000 V 1 mVv 1 MQ of FS | RTD (0.01°, 0.1°, 1° resolution)
200.00 V 10 mV 1 MQ
Type Range Error
600.0 V 100 mV 1 MQ 2V
Pt 100Q | -202 to 850°C |.01% FS +0.03°C
True RMS Amps (0% to 100% of Full Scale, | -00385 | -3311t0 1562°F |.01% FS +0.05°F
0 Hz and 10 Hz to 10 kHz, crest factor 3.0 o
) Pt 100Q | -2021t0 631°C | .01% FS +0.04°C
Range Resol. | Resistance | Error .003925 | -33110 1168°F | .01% FS +0.07°F
2.0000mA | 0.1 pA 100 Q 0.1% Ni 120Q | -80to 260°C |.01% FS +£0.05°C
20.000 mA 1A 10 Q f £S 00672 | -112to 500°F [.01% FS +0.09°F
200.00 mA | 10 pA 10 °
Cu10Q | -97to260°C |.01% FS £0.05°C
5.000 A 1 mA 0.01Q 20 mA .00427 | -143to 500°F |.01% FS +0.09°F
Resistance Measurement Ratio, Potentiometer Follower, Strain
Range Resolution Error Range Resol. |Resistance| Error
0-20.000Q 1 mQ 200.00 mV 10 pv 1GQ 0.01%
0-200.00Q 10 mQ 0.01% 2.0000 V 100 pv 1GQ of FS
0-2000.0Q 100 mQ of FS 20.000 V 1mv 1 MQ 2 cts
0-20000 Q 10 12 cts
0-200.00 kQ 10Q




Load Cell Input

Range Resolution Resistance | Zero Range | Span Range Error

20.000 mV 1uv

50.000 mV 2.5 uv 0

100.00 mV 5 LV 1GQ '9§§§§9t° 0 to £99,999 0'012/"(:?; FS

250.00 mV 12.5 pv -

500.00 mV 25 pv

Thermocouple Accuracy
I 0= 1 =T 0 ] o o o TP 0.003% of reading/°C
0.0015% of reading/°C for load cell meter
A=Y (o T 1= 1 1] Lo o PSS 0.2 pv/°C
Reference JUNCLON ACCUIACY .....uuuueuiiieeeeeieeeiiiiiiaeeeeeeeeeeeatenn e e e e e e eeeeeennnnnnns 1°C, 10°C to 40°C
Dual & Quad Relay Options

Power to Relay OpPtion ..........oooviiiiiiiii e Powered by meter
Setpoint SEUP....cooeieee e Via front panel pushbuttons or RS232/485
UpPdate RALE ... 56/s at 60 Hz, 47/s at 50 Hz
Response to input Signal (MiN) ............eeeeeeimeiiiiiiiiiieeees Display update rate
Input Signal (selectable) ... Filtered or unfiltered input signal
Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status INAICAtION ...........cooiiiiiiiii e 2 or 4 red LED lamps
Status Indication Setup (selectable)....................... Lit when output is ON or OFF, or disabled
Form C, SPDT Relay Output:

Y @ 7= 111 o R 8A @ 240 Vac
[T O = 11 [T 8A @ 24 Vdc
Isolation rating between signal common and contacts ............cccceeeeeeeiiiieiiiiiiieee e, 250 Vac
Insulation dielectric strength between signal common and contacts ..........cccooeeevvvvvveiiicinneeenn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Form A, SPST Solid State Relay Output:

Y O 3= 1] o O PSURRPPPPSR 130 mA @ 140 Vac
[ TG 11 T PP 130 mA @ 180 Vdc
Isolation rating between signal common and CONtacts .............cccceeeeeeeeevvveiiiiiinee e, 250V ac
Insulation dielectric strength between signal common and contacts ...........ccoooeevvieviiiiiiiineeenn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

Analog Output Option

Power to Analog Output OPtiON........cccieeeiiiieeice e Powered by meter
OUIPUL LEVEIS ..o 0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Voltage Compliance, 0-20 MA OULPUL..........ccoeriiiiiiiiiiie e 12V (0-600 Ohm load)
Current Compliance, 0-10V, -10 to +10V Output............ccceuvveeee 2 mA (5 kOhm or higher load)
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ACCUIACY .. Meter input accuracy +0.02% of full scale analog output

RESOIULION ... e e e e e eanaaans 16 bit (1 part in 65,536)
RESPONSE TIMIE ..ottt ee s e e neeeeeee e 50/60Hz update rate
Scaling of Reading for Zero QULPUL..........oooviiiiiiiii e, -99,999 to +99,999
Scaling of Reading for Full Scale Output..............ooooiiiiii -99,999 to +99,999
Isolation rating between signal common and analog outpUt.............cccovvvvviiiiiieeeeeen.. 250V ac
Insulation dielectric strength between signal common and analog Output.............cccccevvvevveeeneee.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
OULPUL TYPES ..ttt RS232, RS485, RS485-Modbus, USB
.......................................... USB-to-RS485 converter, Ethernet, Ethernet-to-RS485 converter
Power to INterface OPtiON........ooviiiiiiiiee e Powered by meter
RSA8BE WIKING ... ceeeeeeeeiie ettt e et e e e e e e e e e et e e e e e e e e e eeaeannnnn s Half or full duplex
Baud RAteS ........evvviiiiiiiiiiiiiiieieeieeeeeeeeeeeeeeeeeeeeeeeeee 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols.........ccccoeveeevvvennnns Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
Signal Levels......ccoooiiiiii e, Meet RS232, RS485, USB, Ethernet standards
Isolation rating between signal common and serial /O ...........ccccoviveiiiiiiiiiiicieee e, 250V ac
Insulation dielectric strength between signal common and serial /O .........ccccooeviiiiiiiiiiiiiinn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Option Board Connectors:
RS 23 et e e e e aaaaa———— Single RJ11 jack
RS485 ..., Two RJ11 jacks (for daisy chaining with 6-wire data cables)
RS485 Modbus.............oveeee. Two RJ45 jacks (for daisy chaining with 8-wire data cables)
0 10) = TSP USB type B plug
USB-t0-RS485 converter.........cccvvvvvvnnnnnnnn. USB type B plug plus RJ11 jack to RS485 bus
EINEINEL. ..o Single RJ45 to Ethernet
Ethernet-to-RS485 converter.............. RJ45 jack to Ethernet plus RJ11 jack to RS485 bus
Environmental
Operating TEMPEIAIUIE ........uuueiii e e et e e e e e e e e e e e e e e eeraaa s 0°C to 55°C
StOrage TEMPEIALUIE ......coeviiiiiiiee ettt e e e e e e e e e e eennnnnes -40°C to 85°C
Relative HumIdity .........cccoooeiiiiiiiiiii e, 95% from 0°C to 40°C, non-condensing
CaSe. oo NEMA-4X (IP65) from front when panel mounted (not verified for UL)
SNOCK e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration .......ooveeviiiii e, 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 24. GLOSSARY OF TERMS |

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched p—
An alarm which stays actuated until reset. Setpoint + ON ™
: 1000| =EtPOINt - *
Latched alarms can shut down machinery or
a process when an operating limit has been Y
exceeded, or maintain an alarm condition ‘
until acknowledged by an operator.

OFF ON ™

er Reading

Alarm, Non-latched
An alarm which changes state automatically T
when the reading rises above a specified limit Setpoint .~ ON
and changes back automatically when the
reading falls below a limit.

Autofilter A selectable digital filter mode which auto- OFF OFF

matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Meter Reading §

NON-LATCHED ALARM

Time

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus
protocol, which is also offered with the meters.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
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often used for component testing. Deviation . .
limits are programmed by entering menu item |50 7@ .
dEU1b for Alarm 1 and dEU2b for Alarm 2. |;5|725® 2 e O
The deviation band will be equal to two limits. | ggo| P255,"%," Sefpoint 9% %
Fail .

Display Blank A rear panel input which blanks the display g .’ Setpoint = 1000
when the input is tied to logic ground by a § Deviation limit = 50
switch or OV is applied (logic level true). The Deviation band = 100
meter display will light when the input is Parts

Setting up a passband around a setpoint is

open or is held at +5V (logic level false).

Extended Meter

Full Scale

A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of
change from successive readings.

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset

Ground Loop

Jumper

Hysteresis Band

A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.

A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure signal conditioner boards for
specific signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.

A band which controls relay action sym- Heater Heater Heater
metrically around a setpoint. The relay . OFF . OFF A OFF
closes (or opens) when the reading goes ' /
above the setpoint plus one hysteresis limit,
and opens (or closes) when the reading
falls below the setpoint less one hysteresis
limit. A narrow hysteresis band is often
used to minimize relay chatter around a
setpoint due to electrical noise or signal
feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump

1050
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Menu Mode

Meter Hold

Modbus

when the tank level has reached an upper limit. The hysteresis band will be
eqgual to two hysteresis limits.

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving Average Filter

Offset

Peak Display

A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milliyamps, offset is O.

The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Process Signal

A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.

Rate of Change Meter

A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
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Reading

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.

Remote Display

Reset

A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.

There are three types of Reset:

= Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.

= Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.

= Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII
command. rESEt is displayed briefly.

RS485 Half Duplex

Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 Full Duplex

Run Mode

Scale

Scaling

Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

A constant multiplier used to go from A/D §
converter counts to displayed counts. This is | >g
the slope term m in the straight line formulay |5 £ Py
= mx + b, where y is the displayed reading in § § ' High input,
counts, m is the scale factor, x is the |2.§ o high reading
measured reading in counts, and b is the &g Low input,
offset. For direct readout in (millvolts or [0 & low reading
(milli)amps, scale is 1. T — Offsetb

0
The process of setting scale and offset so 0 Counts x from A/D converter
that the meter reads properly in engineering Full span -32,768 to 32,768

units (such as psi).

Scaling, Coordinates of 2 Points Method

A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
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then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item.

Scaling, Scale and Offset Method

A scaling method where scale and offset are entered manually. Scaling,
Reading Coordinates of 2 Points Method

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

Setpoint A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the

setpoint.
Span The number of counts corresponding to a given signal range.
Tare A rear panel input which causes the display to be set to zero when the input is

momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Zero When used with process meters, zero is an adjustment so that a given low
transducer output reads zero on the meter. Zero is adjusted by programming
offset.
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| 25. WARRANTY |

Load Cell Central warrants these products to be free of defects in materials and workmanship
for two years from the date of shipment to the original customer. This warranty may be
considered as unconditional provided that, in the opinion of Load Cell Central, the equipment
has not been mechanically, environmentally, or electrically abused and has been installed,
maintained and operated within the limits of rated or normal usage. Defective products must be
sent, transportation charges prepaid, with notice of the defect, to our plant in Monroeton, PA.

This warranty is limited, at the option of Load Cell Central to repair, replacement, or an
appropriate credit adjustment not to exceed the original equipment sales price. All warranty
freight charges are F.O.B. our plant, Monroeton, PA.

Load Cell Central assumes no responsibility in connection with the sale of its products
beyond that stated above and is not responsible for any incidental or consequential loss or
damage which might result from a failure of any Load Cell Central product.

| 26. REPAIR POLICY I

Direct all warranty and out-of-warranty requests/inquiries to Load Cell Central, Customer
Service Repair Dept., Tel: 800-562-3235 (USA) or 570-265-5015, by Fax to: 570-265-5148
or by email to sales@800loadcel.com. Repair work will be handled at the factory or an
authorized service center. All items sent in for service are subject to a minimum evaluation
charge of $65 in the event that the product is found to be out-of-warranty or, if under
warranty, not in need of additional service. Out-of-warranty service and repair charges will
be quoted on a case-by-case basis. All repaired products will be shipped FOB, Monroeton,
PA.

| 27. LOAD CELL CENTRAL PRODUCTS I

Load Cell Central's family of Digital Panel Meters and Large Digit Indicators are high quality,
accurate, solid state instruments designed for years of trouble-free operation. Over 18 years
of digital instrumentation experience has resulted in a series of displays recognized in the
field as reliable, well designed instruments. From our compact sized DPM's with 0.6" LEDs,
to our Large Digit indicators with 1" and 5" LEDs or 4", 6" and 9" tall electromagnetic digits,
we cover most applications in process measurement and display.

In addition to our digital display products, Load Cell Central also manufactures signal
conditioners, load cells, floor scales, crane scales, and turn-key weighing systems. Please
see www.800loadcel.com.

Load Cell Central follows a policy of continuous improvement and reserves the right to change specifications without notice. © 2011

Load Cell Central Toll Free: 1-800-562-3235
216 Main St. / PO Box 91 Ph: 1-570-265-5015
Monroeton, PA 18832 Fax: 1-570-265-5148

Web: www.800loadcel.com 63 Email: sales@800l oadcel.com
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